
Contents of StitchCraft Help
StitchCraft is a program you can use to create cross stitch, tapestry, knitting and 
sewing patterns.
This demonstration copy of StitchCraft has limited Help files, full versions of 
StitchCraft include comprehensive on-line Help. Click on the 'Introduction' or 'How 
To' icons below to access a topic area. To learn how to use Help, press F1.



EPS or WMF?
There are several advantages and disadvantages for both Metafiles and 
Encapsulated Postscript. Firstly Metafiles cannot be used on the Apple Macintosh 
system, also they have a size limit and can become unstable when outputting 
multiple pages on a single piece of film. However Metafiles can be printed out from 
Windows on any desktop printer, unlike EPS which needs a Postscript printer to 
produce a legible image. Metafiles take up less room in your document than EPS 
files. Because Encapsulated Postscript is a language in itself and can be interpreted 
by nearly all bureaus, PC and Macintosh alike, we recommend that EPS be used by 
default for exporting charts.



Exporting to Apple Macintosh.
If you export your chart as an .EPS file, it will be useable on the Macintosh system. 
As with exporting in .WMF, the charts will not be able to be edited, apart from sizing
and rotating, once they have become .WMF or .EPS files. Using .EPS, StitchCraft files
can be imported into DTP programs on the Mac and printed. Alternatively you can 
provide your bureau with an EPS format by printing to file in your Windows DTP 
program. See your DTP program manual for more information (this method is more 
clumsy).



StitchCraft and DTP
StitchCraft can be used in conjunction with Aldus PageMaker, Ventura Publisher, 
Quark XPress, Microsoft Publisher and any other desktop publishing (DTP) programs 
that read Windows Metafile (.WMF) or Encapsulated Postscript (.EPS) format. Once 
placed in a DTP file, StitchCraft charts will appear as graphics: they cannot be 
edited. However, they can be resized and rotated. They can also be augmented with
text and you will have greater flexibility when devising user keys, and so on.

A word of warning: exported charts will require more RAM and disk space than their 
SCC file and will significantly increase the size of your DTP file. If you are producing 
a lengthy document such as a book, you may need to break it up into manageable 
sections.

The method by which you drop a StitchCraft chart into the DTP program depends on
the format in which you exported it. If you selected the Clipboard option in the 
Export Format dialog box, then simply select Paste to drop the chart into your 
document. If you exported it as a .WMF or .EPS file, you will need to Place or Import 
the file into your document.
Instead of creating a user key as part of your chart, you can create a separate chart 
which contains a sample of each symbol and serves as a key to your main chart. 
There are several advantages:
* this key can be positioned away from the chart
* the two charts can be different grid sizes
* explanatory text can be longer and in a variety of fonts.
* text manipulation can be done in the DTP program which has more features for 
working with text and fonts.

You will need to import such user keys separately from the chart to which it refers 
(see appendix for examples).
DTP files containing .WMF StitchCraft charts can be printed on any standard printer, 
though they will take longer to print than a document containing text only. Files 
containing .EPS StitchCraft charts can only be printed on a Postscript printer (level 1
or 2). When printing a chart, especially one with a grey grid on a standard printer 
(e.g. 300 dpi laser) from a DTP program, the quality of the printout will be inferior to
printing directly from StitchCraft. The exported files are designed for high resolution 
output of 1200, 2400 or 4800 dpi. If you are sending the DTP file to a bureau for 
outputting, state clearly that it contains a Windows Metafile or Encapsulated 
Postscript. If your bureau uses PC equipment, they should not encounter problems. 
However if your Bureau uses Macintosh equipment, you must export in .EPS 
not .WMF format or they will not be able to print the charts. 
See:

Start Exporting
Bureau Separation
EPS or WMF?
Exporting to Apple Macintosh



Dither Options
In a chart there are a limited number of thread colors which can be used, therefore 
the colors in the image cannot be perfectly matched with thread colors. Dithering is 
a process whereby different thread colors are used in adjoining cells to simulate the 
required color from the image. The result is that a dithered chart generally looks 
better, but is harder to sew, since there are more single stitches.
There are three options for dithering colors in the Auto Conversion process.
* Dither All - this option gives the most accurate conversion of a photograph.
* Dither Flesh - this option dithers only the flesh tones in the image.
* No Dither - this will produce a chart with no dithering at all. The chart will 
generally have larger blocks of color. It is not normally appropriate for photographs, 
but tends to work well with watercolor images and other drawings where there are 
fewer colors in the original image. 

Note: When using 'Dither All' or 'Dither Flesh', do not select 'Remove single 
stitches'.



Bureau Separation
Once you have exported a chart to a    DTP program, you can then send it on floppy 
disk or by modem to an image bureau for high resolution output.    Accurate color 
separations can also be made. 

Grey Grids
If you are exporting a chart with a grid we recommend outputting at 2400 dpi, 130 
or 133 screen lines per inch. This will ensure consistency in the thickness of the 
grey lines (see fig. 10.5).

Four Color process
Following your specifications, a bureau can produce four pieces of film that combine
to represent the charted colors. These separations can then be used for commercial 
printing in process colors and will give you a chart which closely matches the colors 
you have selected from the thread library, color wheel, RGB, or CMYK. 

Note: It does not matter how you have specified the thread colors they will 
automatically be separated into CMYK when required.
If your chart has a complex color scheme, or if your magazine or book would benefit
from a more colorful chart, consider exporting it with black symbols on color blocks. 
This will convey the image while providing stitchers with sufficient detail to 
distinguish colors. We recommend a setting of about 50% color wash to maintain 
legibility of the symbols. Before the bureau produces film, it is advisable to print a 
full color proof on a desktop color printer. This proof can be done from StitchCraft or 
from the DTP program. 
Note: Again that if printing from a DTP program an .EPS graphic will not print out on 
non-postscript color printers.



Clipboard
A temporary storage location used to transfer data between charts and applications.



Introduction
StitchCraft is a charting aid for any craft based on a counted grid, whether it be 
cross-stitch, tapestry, rug hooking or knitting. 
For information on starting StitchCraft see Starting up StitchCraft.
For more information on the different Editions of StitchCraft see StitchCraft Editions.

StitchCraft can be used for:
Designing

designing new images
creating a library of motifs and borders
plotting charts from scanned images or computer 
generated graphics

Publishing
revising old charts
producing high quality printouts or film
incorporating charts into a desktop publishing application

Prototyping
producing overlays for screen printing tapestries
generating charts for knitting machines 

To make charting easy and efficient, StitchCraft has a wide range of features:
* thread libraries of major brands of stranded cotton and tapestry wool
* ability to automatically match nearest catalogue number to any desired color
* ability to select any color by thread catalogue number
* over 100 basic symbols, with over 1000 possible variations
* four styles of backstitch lines
* a wide range of grid styles and combinations
* a full set of design tools, including backstitch, halfstitch, centermarks 

and text
* three viewing modes: by colors, symbols, or symbols with a color

wash as a background.
* flexible viewing and printing sizes
* ability to move, copy, mirror and rotate sections of a chart
* ability to change symbols and/or colors at any stage
* ability to save cutouts as library files
* ability to chart over images such as scanned photographs, paintings 

or old charts
* ability to automatically convert a scanned image to a chart
* various output options for printing and exporting into a DTP program
* complete mouse control and user-friendly layout



Starting up StitchCraft
If you are at the Windows desktop, double-click on the StitchCraft icon. This will be 
in the StitchCraft group.

If you are in File Manager (a Windows-based application) you can load the 
StitchCraft program by double-clicking on a StitchCraft chart file (ie. one with a .SCC
extension). This will load both the program and the chart selected.

StitchCraft can be run concurrently with other Windows-based applications, such as 
PageMaker and Ventura. Also, if you have sufficient RAM you can run two or more 
StitchCraft windows at the same time, allowing you to move quickly between 
different charts. This has obvious advantages when you want to copy a section from
one chart to another. See your Windows manual for assistance on switching 
between Windows and application programs.



Viewing by Material Count
1. From the Screen menu, select Material Count.

A sub-menu will appear.
2. Highlight the most suitable option.

The chart will approximately match 
the size you have chosen.

This grid size will now appear each time you select True Size from the Screen menu, 
until you specify a new material count. Note that this feature has been designed for 
standard sized screens, rather than large format screens.



Custom Grid
When you select Custom Grid from the Grid Type fly out menu, the Grid options 
dialog box will appear. 
You can now specify the thickness and shade of standard, 5th, 10th and    Centre 
lines separately. Border and Backstitch shade and thickness values can also be set 
from here. In the dialog box there is an option for solid lines, and Grid type and color
can also be specified. You can use the Default option button to reset all values to 
the default, as set in the Preferences dialog box.



Color Wash (Symbol on Color)

When viewing, printing (or exporting - Publisher only) your chart in symbols on color
mode, you may wish to vary the amount of color showing through beneath the 
symbols. This is done using a 'Color Wash'. You can specify as a percentage the 
amount of color showing when viewing, printing or exporting in symbols on color 
mode.



Auto Markings
Use the Auto Markings command to specify whether you want a Border, Center 
Arrows and Center Lines to appear on your chart. When you click on the Auto 
Markings command, a fly out menu will appear listing these three options, a tick will
appear beside each option if it is turned on.



Crop
Use the Crop command to crop the chart to the present cutout size.

1. Define a section of the chart with the Cutout tool.
2. From the Edit menu, select Crop.

The area around the defined section will disappear
and the chart will be reduced in size.



Flip
Use the Flip command to flip the selected cutout either horizontally or vertically 
(see 'Manipulating sections of the chart' in Chapter 5 of your manual).

To flip a cutout
1. Define a section of the chart with the Cutout tool.
2. From the Edit menu, select Flip.

A sub-menu appears.
3. Select the appropriate option.

The contents of the cutout will be flipped
within the defined area, as shown in Figure 5.3.

Note: if no selection is made with the Cutout tool, activating the Flip command will 
flip your whole chart.



Mirror
Use the Mirror command to mirror the selected cutout, creating two facing images 
(see 'Manipulating sections of the chart' in Chapter 5 of your manual).

To mirror a cutout
1. Ensure that there is space clear for the mirrored image; it will only fill 

the space available and will overwrite any existing stitches.
2. Define a section of the chart with the Cutout tool.
3. From the Edit menu, select Mirror.

A sub-menu appears.
4. Select the appropriate option.

The contents of the cutout will be duplicated 
as shown in Figure 5.4 on the next page.

Note: if no selection is made with the Cutout tool, 
activating the Mirror command will double your whole chart.



Rotate
Use the Rotate command to rotate the selected cutout.

To rotate a cutout
1. Define a section of the chart with the Cutout tool 

(if the cutout is not square ensure that there is space available for the rotated 
image).
2. From the Edit menu, select Rotate.

A sub-menu appears.
4. Select the appropriate option.

The contents of the cutout will be rotated,



StitchCraft Editions

Home Edition
The Home Edition offers you the ability to create your own charts for Cross Stitch, 
Tapestry and Rug Hooking. It is licensed for Home use only and printed charts will 
be labelled with "StitchCraft Home Edition". The Home Edition covers the basics of 
designing your own charts in an easy to use layout.
Designer Edition
The Designer Edition is for Professional Designers and serious Enthusiasts - those 
who would like extra design power and a licence agreement which enables designs 
to be sold commercially. It includes many extra features & functions in the same 
easy to use layout as the Home Edition.
Publisher Edition
The Publisher Edition of StitchCraft has it all, the easy to use layout of the Home 
Edition, the creative power of the Designer Edition, and the ability to incorporate 
StitchCraft charts into Desktop Publishing applications. Charts can be easily 
exported for high resolution output. The Publisher Edition is ideal for those who 
want to publish StitchCraft charts in books & magazines.



Zoom In Tool



Alter Symbol
Use the Alter Symbol command to change the shape, shading, or color of a specific 
entry on the symbol section of the Palette.

Also see:
Altering Symbols



Alter Palette
Use the Alter Palette command to:
* add a new palette entry (or entries) which

should then be allocated a color and symbol
* delete an existing palette entry or entries

(if any charted stitches will be deleted by this action,
a warning notice appears)

* change the sequence of entries on the Palette
(this will not affect any stitches)

* swap the position of two entries on the Palette
(this will not affect any stitches)

* merge a palette entry into another one
(this will convert the relevant stitches).

Also see:
Manipulating the Palette



Match Colors
Use the Auto Match Colors command to match every color on your Palette to a 
thread color in a particular brand of commercial threads. You must choose one 
brand from the available range.

Also see:
Matching Thread Colors



Auto Match Symbols
Use the Auto Match Symbols command to match heavy symbols with dark colors 
and so improve the chart's appearance when viewed in symbol mode. You have the 
choice of matching colors to the default range (the clearest and most common 
symbols) or to the range you have selected (rearranging the symbols in your 
existing Palette by weight).

Also see:
Altering Symbols



Auto Minimize Palette
Use the Auto Minimize Palette command to reduce the Palette to those 
symbols/colors which have been used on the chart. A warning notice will appear, 
stating how many entries will be removed from the Palette.

Also see:
Manipulating the Palette



Grid Start
When working on two or more charts that make up one large design, (eg. a double 
page spread in a book), you can use the grid start command to start the numbering 
on your second or third chart, at the place where the previous chart finished. In 
doing this, the numbering will relate to the finished design as a whole, rather than 
each section having numbering that starts from 0,0.

To specify the grid start:
1. From the Chart menu select Grid Start...

The Grid Start dialog box appears.
2. Specify whether the numbering is aligned

to the top left or bottom left.
3. Specify the horizontal and vertical offset of 

the grid (eg. if you want the first vertical stitch 
to be 6, the vertical offset should be 5).

4. Select OK. 



Save Palette
Use the Save Palette command to save a modified palette for use with another 
chart.

Also see:
Saving a Palette



Stitches

* Stitch Pencil
* Half-stitch Pencils

You can use the Stitch Pencil to draw stitches one at a time or in freehand shapes 
and lines. 

To draw stitches on your chart:
1. From the Palette, select the symbol/color you want to use. 
2. From the Toolbox, select the Stitch Pencil and move the pointer into the charting 
area.
3. To draw single stitches, click the mouse button on a chart cell. To draw an area of 
stitches, press the mouse button and drag the pointer.
4. Release the mouse button to stop drawing.

Half-stitches are occasionally used in designs and can be accurately represented on 
this program by using the Half-stitch Pencil. If you are working in color mode, the 
half-stitch will appear as a triangle of color . If you are working in symbol mode the 
half-stitch will appear as a miniature symbol in the appropriate corner with a slash 
dividing the cell . The different tools allow you to specify in which half of the cell the 
stitch will appear.

    To draw a half-stitch:
1.From the Palette, select the symbol/color you want to use. 
2.Double-click on the Stitch Pencil to view all the Stitch options.
3.Select the appropriate Halfstitch Tool and move the pointer into the charting area
4.Click the mouse button on the appropriate chart cell.
The appropriate half of the cell will be filled, either with a color or 
with black.



Stitch Erasers

* Stitch Eraser
* Color Stitch Eraser

The Stitch Eraser deletes all stitches that it touches. You can erase small or large 
areas easily by changing the tool width.

To erase an area of stitches:
1. In the Linesize box, select the tool width you want to use.

The larger the tool width, the larger the Eraser pointer.
2. From the Toolbox, select the Stitch Eraser and move the

pointer into the charting area.
3. To erase single stitches, click the mouse button on the

unwanted stitch. To erase an area of stitches, press the
mouse button and drag the pointer across the unwanted stitches.

4. Release the mouse button to stop erasing.

The Color Eraser works in the same way as the Stitch Eraser, but will only erase 
stitches in the symbol/color currently selected.

To erase stitches in a specific color:
1. From the Palette, select the color/symbol you wish to erase.
2. In the Linesize box, select the tool width you want to use.

The larger the tool width, the larger the Color Eraser pointer.
3. Double-click on the Stitch Eraser to view the hidden icons.
4. From the Toolbox, select the Color Eraser and move the

pointer into the charting area.
5. Click the mouse button on a single unwanted stitch or drag

the pointer across an area of stitches; only those in the
specified color/symbol will be erased.



Stitch Shapes

* Chain
* Box
* Filled Box
* Circle/Ellipse
* Filled Circle/Ellipse

Chain
The Chain tool allows you to draw a continuous sequence of stitches quickly and 
accurately.
To draw a chain of stitches:
1. From the Palette, select the symbol/color you want. 
2. From the Linesize box, select the tool width you want.

The larger the tool width, the thicker the chain.
3. From the Toolbox, select the Chain tool and move

the pointer into the charting area.
4. Press the mouse button to anchor one end of the chain

and drag the mouse: a flexible line will stretch from
the anchored point.

5. When you are satisfied with the length and position of
the flexible line, release the mouse button; a sequence
of stitches will be pasted in place.

Note: To draw a perfectly straight horizontal, vertical, or diagonal chain, hold down 
the SHIFT key as you drag the flexible line: the chain will jump to the closest angle.

HINT If you accidentally release the mouse button too soon use Edit/Undo to 
remove the mistake.

Also see:
Box
Filled Box
Circle/Ellipse
Filled Circle/Ellipse



Box
The Box tool allows you to draw a square or rectangle of stitches quickly. Note that 
any box drawn will overwrite any existing stitches in its path.

To draw a box of stitches:
1. From the Palette, select the symbol/color you want. 
2. From the Linesize box, select the tool width you want to use.

The larger the tool width, the thicker the border of your box.
3. Double-click on the Chain tool to view further icons
4. Select the Box tool and move the pointer into the charting area.
5. Press the mouse button to anchor one corner of the flexible box.
6. Holding down the mouse button, move the pointer until the box is the desired
size.
7. Release the mouse button; a box-shaped sequence of stitches will be pasted in 
place.

Note: To draw a perfect square of stitches, hold down the SHIFT key while dragging 
the flexible box.

HINT If you accidentally release the mouse button too soon use Edit/Undo to 
remove the box.



Filled box
The Filled Box tool allows you to draw filled boxes or squares of stitches quickly. It 
operates in the same way as the Box tool



Circle/Ellipse
The Circle/Ellipse tool allows you to draw a circle or oval of stitches quickly.
To draw a circle or ellipse of stitches:
1. From the Palette, select the desired symbol/color. 
2. From the Linesize box, select the desired tool width.

The larger the tool width, the thicker the circle or ellipse.
3. Double-click on the Chain tool to view further icons.
4. Select the Circle/Ellipse tool and move the pointer into the charting area.
5. Press the mouse button to anchor one corner of the flexible ellipse.
6. Holding down the mouse button, move the pointer until the ellipse is the 
desired size.
7. Release the mouse button; an oval sequence of stitches will be pasted in place.
Note: To draw a perfect circle of stitches, hold down the SHIFT key while dragging 
the flexible circle.

HINT If you accidentally release the mouse button too soon use 
Edit, Undo to remove the mistake.



Filled circle/ellipse
The Filled Circle/Ellipse tool allows you to draw a filled circle or oval of stitches 
quickly. It operates in the same way as the Circle/Ellipse tool



Rollers

* Paint Roller
* Variegated roller

Paint Roller
Use the Paint Roller to fill in any closed shape or area with the selected symbol or 
color. The symbols in the boundary can be different to that used as a filler, or they 
can be the same.

To fill in a closed area with the Paint Roller:
1. Ensure there are no gaps in your boundary.
2. Select the symbol/color you want to use in the fill.
3. From the Toolbox, select the Paint Roller.
4. Position the pointer in the closed shape and click the mouse button.

The area will fill with the selected color/symbol.

If the shape being filled has any breaks in its border, the filler will leak out and fill all
blank cells in the chart. If this happens, wait for the color to stop leaking and select 
Undo from the Edit menu (or press CTRL + BACKSPACE).    It is a good idea to save 
your work before using this tool!

Also see
Variegated roller



Variegated Roller
Occasionally, a design calls for an area of randomly colored stitches. Use the 
Variegated Roller to fill in any closed shape with a random arrangement of selected 
symbols or colors.

To fill in a closed area with the Variegated Roller:
1. Create a boundary of stitches and ensure there are no gaps in it.
2. Double-click on the Paint Roller to view the hidden icons
3. Select the Variegated Roller; a dialog box appears.
4. Specify the colors/symbols you wish to use by nominating their

location on the Palette (eg. dark grey/cross is No. 2).
5. Specify the percentage in which each one should appear. If your

selections do not add up to 100%, the unspecified percentage will
remain in the background color.

6. Position the pointer in the closed shape and click the mouse button.
The area will fill with the selected colors/symbols.

If the shape being filled has any breaks in its border, the filler will leak out and fill all
blank cells in the chart. If this happens, wait for the colors to stop leaking and select
Undo from the Edit menu (or press CTRL + BACKSPACE). To avoid any problems, 
save your work before using this tool.



Backstitch

* Backstitch tool
* Half-backstitch tool

The Backstitch tool can be used to draw backstitching or other lines on your chart. 
Where a backstitch pattern changes course, draw the pattern as a series of 
separate lines. Lines drawn with this tool will always start and end on the corner of 
a cell.

To draw a line:
1. From the Palette, select the color you wish to use.
2. From the Toolbox, select the Backstitch tool and move

the pointer into the charting area.
3. Press the mouse button to anchor one end of the line and

drag the mouse: a flexible line will stretch from the anchored point.
4. When you are satisfied with the length and position of the

flexible line, release the mouse button. 
5. If you want a series of lines, repeat steps 3 and 4.

Note: To draw a perfectly straight horizontal, vertical, or diagonal line, hold down 
the SHIFT key as you drag the flexible line.

HINT Backstitching slows down the speed at which StitchCraft 
works, so it is wise to leave any backstitching until the end.

The Half-backstitch tool works in the same way as the Backstitch tool, but allows 
you to draw lines which start and end between gridlines.



Backstitch Erasers

* Backstitch Eraser
* Color Backstitch Eraser

The Backstitch Eraser deletes any lines which start or end in the area it touches. You
can erase small or large areas easily by changing the tool width.

To erase a line:
1. In the Linesize box, select the tool width you want to use.

The larger the tool width, the larger the Eraser pointer.
2. From the Toolbox, select the Backstitch Eraser and move

the pointer into the charting area.
3. To erase a single line, click the mouse button on the end of

the unwanted stitch. To erase an area of backstitch lines, press
the mouse button and drag the pointer across the ends of the unwanted lines.

4. Release the mouse button to stop erasing.
Note: If several lines end at the same location, clicking on that area will erase them 
all. To erase such lines selectively, consider clicking on the other end of the 
unwanted line.

The Color Backstitch Eraser works in the same way as the Backstitch Eraser, but will
only erase lines in the color currently selected. 



Centermarks

* Arrow Pencil
* Centerline

When printing or exporting a chart, you are given the option of automatic arrows to 
indicate its center. However, if you have split one chart into sections, or if the center
of your chart is not the centre of your design, you may wish to place arrows 
manually. The thickness of arrows drawn with the Arrow Pencil is set in the Options 
command of the Print and Export menus. Remember to turn off the automatic 
arrows before you print .

To manually draw arrows on your chart:
1. Calculate the position on the chart where you require the arrow(s).
2. From the Toolbox, select the Arrow Pencil and move the pointer into the charting 
area.
3. Press the mouse button to anchor the base of the arrow's shaft.
4. Drag the pointer to where the arrow head should appear and release the mouse 
button.

When printing or exporting a chart, you are given the option of automatic 
centermarks to indicate its centre. However, if you have split one chart into 
sections, or if the center of your chart is not the center of your design, you may 
wish to place these lines manually. The thickness of lines drawn with the Centerline 
tool is set in the Options command of the Print and Export menus. Remember to 
turn off the automatic centermarks before you print .

To manually place centerlines on your chart:
1. Calculate the position on the chart where you require the center lines.
2. Double-click on the Arrow Pencil to view the hidden icons.
3. Select the Centerline Tool and move the pointer into the charting area.
4. Press the mouse button to anchor the base of the vertical line.
5. Drag the pointer to where the vertical line should end and release the mouse 
button.
6. Repeat steps 4 and 5 for the horizontal line.



Centermark Erasers

Use the Centermark Eraser to erase manual arrows or centerlines.

To remove a centermark:
1. From the Toolbox, select the Centermark Eraser

and move the pointer into the charting area.
2. Click the mouse anywhere on the arrow or

centerline you wish to remove.



Borders

* Freehand Border
* Box Border
* Elliptical Border

The Freehand Border tool allows you to manually place a border (ie. a thin line) 
around a chart or around a label. A border line is different from a backstitch line: it 
will only travel along gridlines, it cannot be colored or dot-dashed, its printed 
thickness is set separately from that of backstitch. If you are charting a knitting 
pattern, you might want to 'crop' the grid around the shape of a sleeve and draw a 
border round the edges (see the section on charting knitting patterns in 'Advanced 
Charting Methods' and the sample knitting design in the appendices of your 
manual).

To manually draw a border:
1. From the Toolbox, select the Freehand Border

tool and move the pointer into the charting area.
2. Press the mouse button to anchor one end of the

line and drag the mouse: a flexible line will stretch
from the anchored point. It will only travel along a
vertical or horizontal path.

4. When you are satisfied with the length of the flexible line, release the mouse 
button. 
5. Draw connecting lines until the border is complete.

You might want to have a border surrounding the grid section of your chart, but not 
surrounding the label which contains the key to thread colors and so on. 

To manually place a rectangular or square border:
1. Double-click on the Border tool to view the hidden icons.
2. From the Toolbox, select the Box Border tool and move

the pointer into the charting area.
2. Press the mouse button to anchor one corner of the box

and drag the mouse: a flexible box will stretch from the
anchored point.

3. When you are satisfied with the size and position of the
flexible box, release the mouse button. 

The Elliptical Border operates in the same way as the Box Border. The thickness of 
borders drawn with the Border Pencil is set in the Options command of the Print and
Export menus.



Border Eraser

Use the Border Eraser to erase manual borders.

To remove a border:
1. From the Toolbox, select the Border Eraser and move the pointer into the charting
area.
2. Click the mouse anywhere on the border you wish to remove.



Label Tools

* Box Label
* Box Label /Border
* Circle/Ellipse Label
* Circle/Ellipse Label/Border

The Label Pencil allows you to place an area of solid white on your chart so that text
placed on it will be more legible. You can choose whether or not this label has a 
border line around it by selecting the appropriate icon from behind the Label Pencil: 
the second and fourth tools will draw labels with borders.

To draw a rectangular or square label:
1. Double click on the Label Pencil in the Toolbox

to view hidden icons.
2. Select the appropriate Box Label tool and move

the pointer into the charting area.
2. Press the mouse button to anchor one corner of

the flexible box.
3. Holding down the mouse button, move the pointer

until the box is the size you want your label to be.
4. Release the mouse button.

To draw an elliptical label:
1. Double-click on the Label Pencil in the Toolbox

to view the hidden icons.
2. Select the appropriate Elliptical Label tool and

move the pointer into the charting area.
3. Press the mouse button to anchor one corner of

the flexible ellipse.
4. Holding down the mouse button, move the pointer

until the ellipse is the size you want your label to be.
5. Release the mouse button.

Note: You can draw a label over existing text or stitches; they will be visible through 
the label although the gridlines will not.



Label Eraser

The Label Eraser is useful for removing labels which are in the wrong place or which 
are the wrong size.

To remove a label:
1. From the Toolbox, select the Label Eraser and move the pointer into the charting 
area.
2. Click the mouse anywhere on the label you wish to remove.



Text

The Text tool allows you to write text (such as the name of the design or designer) 
or construct a user's key on a section of the chart. Default text is written in Times 
Roman with a letter height of two cells but you can vary the font, size, style or color 
of text to be written.

Font options are determined by your printer and the version of Windows in which 
you are operating. If you are running Windows 3.1 or higher, you will have additional
options of true type fonts (marked with TT in the font list). It is preferable to use 
true type fonts because they can be resized without any problems. See your 
Windows manual for more information on such fonts.

Letter height can be any size between one-cell and twenty-cells-high. The height 
includes leading (ie. the space between lines). Text can be written in one of four 
colors: black, red, blue or green. Style options include normal, bold, italic or 
underlined. Various combinations of the last three options are possible.

The above mentioned options (fonts, letter height, text color and style) are selected 
from the option box. A sample box in this dialog box shows the specified format; to 
view further sample letters or the number 0 to 9, use the scroll bar at the right of 
the sample box.
To write text on your chart:
1. From the Toolbox, select the Text tool and move

the pointer into the charting area.
The pointer will appear as an I-bar.

2. Point with the base of the bar to where you want
your text to appear and click the mouse button.
The Text dialog box appears.

3. Select the desired font, letter height and color
from appropriate lists.

4. Click on the appropriate box(es) in the Style section. 
5. Click in the Text section and start typing. 

To correct errors, use the BACKSPACE key.
6. Select OK.

To add another line of text, reposition the Text pointer in the appropriate cell and 
click the mouse button. 

When you review the charted text, you may wish to make some changes.

To edit text already placed on the chart:
1. From the Toolbox, select the Text tool.
2. Move the pointer to the text which needs to be edited.

The pointer will change to a T-arrow when it locates text.
3. Click the mouse button anywhere on the text.

The Text Options dialog box appears.



4. Click anywhere in the Text area and edit as desired.
5. Make any desired font, height, color or style changes.
6. Select OK.



Cutouts

With the Cutout tool, you can define a square or rectangular area of your chart 
which can then be cut, copied, pasted, manipulated or saved. The cutout can be 
very small, as large as the drawing area, or the whole chart.

To define a rectangular or square cutout:
1. Ensure that the section you wish to define

is within the charting area.
2. From the Toolbox, select the Cutout tool and

move the pointer into the charting area.
3. Press the mouse button to anchor one corner

of the flexible box.
4. Holding down the mouse button, move the pointer

until the box encloses the area you want to define.
5. Release the mouse button.

The cutout remains highlighted by a thick line.

You can now use commands from the Edit menu to cut, copy, paste, manipulate and
save the cutout. 

To undo a selection, choose Deselect from the Edit menu or click on another tool.



Stitch Size
Use the Stitch Size command to set the width of the stitch tools: a sub-menu offers 
a choice of size 1 (narrow) to size 8 (broad).

Also see:
Tool Width



Eraser Size
Use the Eraser Size command to set the width of the eraser tools: a sub-menu offers
a choice of size 1 (narrow) to size 8 (broad)

Also see:
Tool width



View
Use the View command (in Screen menu) to select a specific viewing size. This may 
be a quicker alternative to using the Zoom In and Zoom Out icons and is the only 
way of making the chart fill the whole screen. From here you can also specify your 
viewing preferences - whether or not you want to see the grid, rulers, cursor 
position etc.

Also see :
Viewing sizes



Viewing sizes

To change the viewing size:
1. From the Screen menu, choose View...
2. Click in the button beside the preferred

view and select OK. Alternatively, you
can use the Viewfinders to zoom in and
out between the three most useful sizes:
large edit, small edit, and whole chart.

To zoom in:
1. Click on the zoom-in icon; a magnifying glass will appear.
2. Position the magnifying glass on the section of the screen you wish to enlarge, 
and click.
Alternatively, double-clicking on the zoom-in icon will return you to your last 
zoomed-in position.
To zoom out:
Click on the zoom-out icon and viewing size will automatically change.

Cross stitch and tapestries are stitched on even weave material with a specific 
number of threads per inch or centimetre. StitchCraft lets you view your design 
according to various common counts for Aida fabric which is measured in inches. If 
you are using linen or canvas, you will need to estimate the number of stitches per 
inch and choose the closest measure offered. Using this feature, you can foresee 
how a design will appear when stitched, see: Viewing by Material Count.



Calibrate
Use the Calibrate command to correctly set the brightness and contrast on your 
monitor. For more information, see 'Screen quality' in the Appendix on Technical 
Specifications of your manual.



Material Count
Use the Material Count command to set the size for True Size, which allows you to 
view your design at the size it will be when stitched.
To view the chart according to the material count:
1. From the Chart menu, select Material Count.

A sub-menu will appear.
2. Highlight the most suitable option.

The chart will approximately match 
the size you have chosen.

This grid size will now appear each time you select True Size from the Screen menu, 
until you specify a new material count. Note that this feature has been designed for 
standard sized screens, rather than large format screens.



Grid Type
Use the Grid Type command to change the shape and weighting of the gridlines on 
your screen. The options are:
* ten square grid - a heavy line every tenth gridline
* five square grid - a heavy line every fifth gridline
* plain square grid - all gridlines equally weighted
* dot grid - dots in place of solid gridlines
* knitting grid - stretches the grid horizontally to show knitting pattern distortion.



Palette Display
Use the Palette Display command to remove or replace the following:
* the entry numbers of the Palette(useful as a reference when manipulating the

Palette).
* the color section of the Palette.
* the symbol section of the Palette.

To add any of these to the screen or to remove them, simply select the relevant 
item from the sub-menu.



Import Menu
One of the most valuable features of StitchCraft is the facility for importing an 
image which can be either placed behind a grid and then charted over, or 
automatically converted to a chart by StitchCraft. 

Importing an image
The import can be a scanned image (a photograph, a hand-drawn picture, an old 
chart) or one created in a graphics program such as Paintbrush. You can import an 
image via the clipboard or direct from a bitmap file (you will be asked to specify the 
source).

To import from the clipboard
To import from a bitmap file

Also see:
Charting over an image
Auto Conversion
Removing the import



To Import from the Clipboard
1. While in your graphics program

(such as a paint or scanning program),
copy the desired image to the Clipboard using Edit, Copy.

2. Activate the StitchCraft window.
3. If you wish to fill only a part of your chart, select the

Cutout Tool and use it to define a suitable area for the import.
If no cutout is selected, the import will fill the whole chart.

4. From the Import menu, select Import.
The Import Format box appears.

5. Click on the Clipboard option button.
6. Select OK.

If you have selected a cutout and the image to be imported does not neatly fit those
proportions, StitchCraft will ask if you wish to stretch the image or would prefer the 
image to be placed in the top-left of your chart, as large as possible while retaining 
its proportions.



To import a bitmap file
1. While in your graphics program (such

as a paint or scanning program), save the
file in a bitmap format, with a *.BMP extension.

2. Activate the StitchCraft window.
3. If you wish to fill only a part of your chart, select

the Cutout Tool and use it to define a suitable area
for the import. If no cutout is selected, the import
will fill the whole chart.

4. From the Import menu, select Import.
The Import Format box appears.

5. Click on the Disk file option button.
6. Select OK.

The Open File box appears, with a directories list.
7. Double-click the directory that contains the import file.

All files with a *.BMP extension will appear in the file list.
8. Double-click on the file that you want to import.

If you have selected a cutout and the image to be imported does not neatly fit those
proportions, StitchCraft will ask if you wish to stretch the image or would prefer the 
image to be placed in the top-left of your chart, as large as possible while retaining 
its proportions.



Charting over an Image
You can now chart over the image using the tools as usual. Work in the symbol 
mode (rather than color) so you can see which areas have been charted. Remember
to save your chart as usual, to protect your work.

HINT Unlike normal charting, where backstitch is drawn last to
avoid slowing the program, you should backstitch over an 
import first. Otherwise, you won't be able to see where 
backstitch lines are required.

StitchCraft even helps you to select appropriate colors for charting any section of 
the import. Simply click the right-hand button of the mouse on a cell of the import 
and StitchCraft will highlight the closest color available from your Palette. Double-
click the right button on that cell and it will automatically select that color. 

Alternatively, you can build up a palette by matching selected colors in the import 
itself. StitchCraft will identify the predominant color in a specified cell of the 
imported image and let you add it to the Palette. You can then use the Auto Match 
command to match the whole Palette with thread colors from a commercial range.
To match colors in an import:
1. Hold down the INSERT key.
2. Click with the right-hand mouse button on a

cell of the import and release the INSERT key.
The Alter Color dialog box appears, with a
color in the sample box.

3. Select OK.
This color will be added as an entry to the Palette.

4. Repeat for as many cells as required.
5. From the Palette menu, select Auto Match Colors.
6. Click on the option box for the desired brand of threads.
7. Select OK.

Each color in the Palette will be matched to a
thread color in that range.

It would be impractical to match every cell of the import: you may end up with a 
chart using hundreds of different thread colors. The charter must decide how many 
different colors they wish to use and where variations are most important.



Removing the import
To view your progress without clearing the import (which is a permanent step), you 
can elect to view the import only, the chart only, or the two combined.
To change the import view:
1. From the Screen menu, select View.

The View dialog box appears and, if an image
has been imported, the relevant options will
appear in the bottom left of the box.

2. Select the appropriate import viewing mode.
3. Select OK.

When you have completed your chart, clear the import by selecting Clear Import 
from the Import menu.

Only one imported image can be used at a time. However, once an import is 
cleared, you can import another image and proceed as outlined above. This allows 
you to build up a design using imported images as elements in a collage.

If you wish to retain an import you can save it as a *.BMP file from your painting or 
scanning application. Alternatively, you can save it as a *.CLP file from the Clipboard
Viewer.



Preferences
The Preferences dialog box gives the ability to specify the start-up settings for 
StitchCraft and the default settings for each new chart.
There are several settings:
* Autosave - lets you specify whether autosave is off, auto or remind. 

You can also specify the interval between autosave actions.
* Chart size - enables you to set the size for each new chart

created in StitchCraft.
* Markings - enables you to specify whether each new chart has 

centrelines, centre arrows or a border.
* Grid - lets you specify values for type, color, shade & thickness

of grid on each new chart. The Grid section also contains
options for solid lines, knitting grid and count from bottom.

* Thread - enables you to select the brand and type of thread for
each new chart. Alternatively you can select under the Palette
heading; the StitchCraft default palette, the previously saved
user palette, or you can save your current palette as the default.

To set your Preferences:
1. Select Preferences... from the File menu.
2. Specify your preferences.
3. Click OK. Each new chart you start will

now have the preferences you have selected.



Clear Import
Use the Clear Import command to permanently remove an imported image from the
screen.

Also see:
Import menu



Export Menu  (only available on Publisher Edition)

Use the Export menu commands to output charts in a format suitable for use in a 
desktop publishing program.
There are several decisions to be made before you export a chart. As when printing,
you specify desired gridline widths, chart size, and    whether or not registration 
marks are to be added. You should also specify the format of the export.

Select from one of the following commands:
Start Exporting
Export Format
Export Layout



Start Exporting
Use the Start Exporting command to:
* specify the export format
* specify the export layout
* specify the export options
* view a summary of the current export settings
* export the current chart.

1. From the Export menu, select Start Exporting.
The Export dialog box appears.

2. Select an Export Type and change Layout & Options if desired.
3. Select OK.

Before exporting, you can change the color of the gridlines or choose to have no 
gridlines at all. You can also choose between the various chart types: symbol chart, 
color chart, symbols on color, symbol overlays , color overlays or tapestry overlays 
(optional extra). 
see:

Export Format
Export Layout
Export Options
StitchCraft and DTP
Printing in color



Color Overlays
Of use if you are publishing a chart in color blocks with only a few colors (e.g. a 
knitting pattern). This option will output each of the palette colors separately for 
printing on separate overlays. If more than 4 colors are used it may be cheaper to 
use 4 color separation methods and print in 4 color process (see full color 
separation). Unlike Tapestry overlays, Color overlays fit together without any 
overlap.



Export Format
Use the Export Format command to change the format in which a chart will be 
exported, either to the Clipboard or to a file. 
There are two reasons you may wish to export StitchCraft files into another format: 
to improve reproduction quality, and to incorporate charts into a document, such as 
a book. Two Export formats are available from StitchCraft - EPS and WMF (see EPS or
WMF?). Exporting in either format enables a bureau to separate the chart for 
commercial printing using process colors. Even if you only require monotone output 
(ie black symbols on a black grid), a bureau can output at a much higher resolution, 
giving you a clearer, sharper image. StitchCraft charts exported in EPS or WMF 
format can also be imported into desktop publishing packages such as Aldus 
Pagemaker, Quark XPress and Ventura Publisher, where they can be enhanced. 
Charts exported in EPS format can also be used on the Apple Macintosh system, see
Exporting to Apple Macintosh.

By default, a chart will be exported to the Clipboard in WMF format. If you require an
EPS or WMF file instead, you must specify this before exporting.
1. From the Export menu, select Export Format.

The Export Format dialog box appears .
2. Click on the appropriate option button.

If you select one of the Disk File options, an Export File dialog box 
appears, and you must allocate a file name.

3. Select OK.



Export Layout
Use the Export Layout command to:
* specify a height or width for the exported chart
* specify the gridsize of the exported chart.

1. From the Export menu, select Export Layout.
The Export Page Layout dialog box appears. 
The default setting is a grid size of 10 cells per inch (10 count). 

2. You can adjust the exported chart size by width,
height, grid size or count.

3. Enter the desired size in the appropriate section of the
Measurements box and StitchCraft will adjust any other
affected measurements.

3. Select OK.

The chart size will then be displayed in the Chart section of the Export dialog box.



Export Options
Use the Export Options command to change the line thicknesses and shades of 
gridlines, centermarks & backstitch. If you were charting manually on paper, you 
would choose graph paper with an appropriate line thickness and weighting. 
StitchCraft has these same options: line thickness and shade can be adjusted and 
every 5th or 10th gridline can be accentuated to make the chart easier to use.    You 
can also adjust the thickness and shade of any centermarks, border and backstitch. 

To change line thicknesses:
1. From the Export menu, select Export Options.

The Export Options dialog box appears.
2. Use the scroll bars to choose from the five shade and nine

thickness settings for the appropriate lines. A sample
appears at the right of the scroll bar. If you are dissatisfied
with the changes made, click on Default to revert to
original settings. You can also specify a solid grid, which
will change all shades to 100%. 

3. Select OK.



Start Printing
Use the Start Printing command to:
* specify the print output (color/mono, symbols/blocks, etc)
* specify gridline type (black/color/none)
* view a summary of the current print settings
* print the current chart.

also see :
Printing in Color



Printer Setup
Use the Printer Setup command to change the target printer. 

Also see:
Changing Printers and Printer Options



Page Layout
Use the Page Layout command to:
* change the margins on the page
* specify a height or width for the printed chart
* specify the gridsize of the printed chart
* specify the chart's position on the page.
* specify the number of pages in Tile, if

the chart is to printed over more than one page.

Also see:
Specifying Printed Size and Position



Print Options
Use the Print Output command to:
* change the line thicknesses of gridlines, centermarks, backstitch
* add or remove automatic centerlines, arrows, borders, 

or registration marks.

Also see:
Gridline Options



Rulers and Co-ordinates
Along the top and left-hand side of the chart is a Ruler marking the width and height
count. This can be very useful if you are working on a large chart, and need to know
which section you are currently viewing. It is also a useful reference when you wish 
to add or delete columns or rows and need to specify position. 

A box indicating the co-ordinates of the pointer position is another feature offered. 
The Ruler and the Co-ordinates Box are both optional. 

To add or remove these items:
1. From the Screen menu, select View.

The View dialog box appears.
2. Click on the appropriate check boxes.
3. Select OK.



Using help
StitchCraft online Help is a convenient, quick way to look up information about a 
task you are performing, a feature you would like to know more about, or a 
command you want to use. Help is available at almost any time.

Contents:
The contents help menu contains all help information accessed through branches of 
main headings.Within contents you may also use the browse buttons ( << or >>) 
which allows you to look at the following page(s).

Search:
The Search feature is an efficient way to find the information you need. When you 
have a topic you want help with, you can select or type it in the Search dialog box 
so that Help can find the information for you.

Context Sensitive:
When you select Context Sensitive from the Help menu bar, a pointer with a 
question mark will appear.The pointer will move with your mouse and allow you to 
click on any command or parts of the screen that you want help on.

Help from Dialog Boxes:
When a dialog box appears, pressing F1,will activate a Help window for that topic
For more details in using help in general,press F1 now.



Creating a Simple Chart
With the default chart on the screen, you are ready to start basic charting.

Select a tool
Select a tool width
Select a symbol / color from the Palette
Draw your chart
Correct any errors
Save your work



Select a Tool
Before you begin working in the charting area, you need to select the tool you want 
to work with. This can be done from the Toolbox at the left of the StitchCraft window
or from the Tools menu. The Stitch Pencil is always selected by default when you 
start StitchCraft or when you open a new chart.

To select a tool:
Point to the tool you want to use and click the mouse.
StitchCraft highlights the selected tool in the Toolbox.

Each tool works slightly differently, but the basic technique is to select a tool, move 
to the charting area and click on the cells which you want to modify.



Selecting Tool Width

The Linesize box in the lower-left corner of the window displays the available widths 
for drawing and erasing. You can set different widths for drawing and erasing: you 
might prefer to keep the drawing tools precise and the erasing tools broad. You can 
change these widths at any time when charting.

The arrow on the left of the width bars indicates the coverage of any pencil tool you 
select. For example, if you are drawing stitches with the Stitch Pencil, the drawing 
width determines the size of the pencil stroke and so the number of stitches that 
will be filled in. 

The arrow on the right side of the width bars indicates the coverage of any eraser 
tool you select. Use a wide tool width for covering or erasing large areas of the chart
quickly. You might want to experiment with how different tool widths work with 
different tools so that you can use them most effectively.

To change the width of the drawing tools:
Click the mouse to the left of the desired width bar. 
An arrow appears to the left of the drawing width you selected.

To change the width of the eraser tools:
Click the mouse to the right of the desired width bar. 
An arrow appears to the right of the eraser width you selected.



Using the Palette
Charts for cross stitch or any counted craft indicate to the user which color thread or
yarn is used where. StitchCraft offers a choice of 50 basic colors and each color is 
represented by a corresponding symbol and allocated a number; these color/symbol
combinations make up the Palette which runs across the bottom of the StitchCraft 
window. The Palette sometimes extends further than the screen can display; to view
the extra symbols/colors, click on the scroll bar below the Palette.

The Selection box to the left of the Palette shows the symbol or color that is 
currently selected. The option buttons between the Selection box and the Palette 
switch your chart view from symbols to colors or vice versa. The Selection box will 
indicate which viewing mode you are currently in.

When you start up StitchCraft, the selected symbol/color is box/black (the 
combination at the extreme left of the Palette). If you use the drawing tools, the 
stitches will appear either as a box symbol or as a black square. You can select a 
different symbol/color at any time and so build up a chart of different 
symbols/colors.

To select a different symbol/color:
Point to the desired symbol or color in the Palette and click the mouse.
The Selection box show the symbol or color you have selected.

HINT Double-clicking the right-hand mouse button on a particular 
cell of your chart will select the symbol/color already used in 
that cell.



Drawing a Chart
To draw with any selected tool, simply follow these steps:
1. Click on the Stitch Pencil in the Toolbox.
2. Move the pointer to the charting area.
3. Click on the cell where you require a stitch in the selected color/symbol.

A symbol (or block of color) will appear in that cell.
4. Repeat the last step in another cell, or drag the pointer across several cells.



Correcting Any Errors
If you make a mistake while charting, you can use the Undo command on the Edit 
menu to make simple corrections. 'Undo' reverses your very last action, whether it 
was an addition or an erasure.

Undo will not have any effect if your last action was to select a tool, use the scroll 
bar, or resize the window. Once you do any of these and you wish to edit your work, 
you must use an eraser tool or restore the version last saved.

Also see:
Using the Erasers



Saving your Work
The File menu contains two different commands for saving chart files: Save and 
Save As. Use the Save command to save changes to an existing file. Use the Save 
As command to name and save a new file or to save an existing file under a new 
name. When you are charting a design - especially a large design - you should save 
the file often. 

To save an existing chart file:
From the File menu, select Save (or press CTRL + S).

To save a new chart, or an existing chart under a new filename:
1. From the File menu, select Save As.

A Directories list box appears.
2. Select the directory in which you want to save the file.
3. Move to the Filename text box and type the name you want

to assign to the file (up to eight characters with no spaces).
4. Select OK.

As a precaution against losing important work, StitchCraft has an Auto-save 
function. By default, a reminder box will appear on screen after a gap of 10 minutes,
asking if you wish to save. You can change the frequency of the reminder, save 
automatically without an option, or turn Autosave off altogether - see Saving 
Automatically.



Editing your chart
One of the strengths of StitchCraft is the ease with which you can edit your work. 
When charting manually, a series of changes may mean starting afresh; with a 
computer it can simply mean a few adjustments.
This chapter contains information about features to help you review your work and 
make improvements.

Reviewing charts
Opening an existing chart
Using the eraser
Manipulating sections of the chart
Identifying stitch colors
Choosing an unused symbol/color



Reviewing charts
The characteristics of each chart file are summarized in a box called File 
Information. This can be used to learn about a chart on screen or about one you are 
considering opening. It contains:
* the file name and date it was last saved
* the width and height of the chart
* the palette size and number of entries used
* the number of color separations used
* a text box in which you can store notes about the chart
You can enter text only for a chart that is currently open; you are restricted to 
viewing it when the file is unopened.

For information on a chart currently on screen:
1. From the File menu, select File Info.

The File Information box appears.
2. To enter text, click in the text area and type.

Text wraps automatically; do not press ENTER until you have 
completed your text message.

For information on files not yet opened:
1. From the File menu, select Open.

The Open File dialog box appears 
2. Click on the appropriate file in the Files list box to highlight it.
3. Click on the Info option box.

The File Information box appears.
4. When you have finished viewing the information, click OK.

At any stage of charting, you can recall a list of the last five charts opened and, if 
you wish, open one of them. If you do so, the recalled chart will replace your current
chart on screen.
To recall a recently used file:
1. From the File menu, select Recall.

A sub-menu appears, listing the last five files used.
2. Click on the file you wish to recall.



Opening an existing chart
You can open a chart at any stage. If you attempt this while working on another 
chart, StitchCraft will ask you if you wish to save the chart currently on screen. 
StitchCraft only runs one chart at a time. (If you wish to run two charts concurrently 
and have sufficient RAM, you can start up another version of the StitchCraft 
application in Windows and then jump between the two versions using ALT + TAB.)

To open a chart:
1. From the File menu, select Open.

The Open File dialog box appears.
2. Move to the Directories list box.
3. Double-click the directory that contains the file you want to open.
4. Move to the Files list box and scroll through to find the file you want.
5. Double-click the filename or choose OK.

HINT If you have a long list of files, you can click on the first one
and then type the first letter of the required file to jump down 
the list.



Using the Eraser
It is a simple matter to correct an error or to make changes to your chart using the 
eraser tools. StitchCraft has several eraser tools, each with a different function:

Stitch Eraser    By dragging the pointer over your chart, you can 
remove all the stitches your eraser touches. 

Color Eraser If you wish to erase stitches selectively, use the
Color Eraser. This works in the same way as the
Stitch Eraser but will only erase stitches in the
symbol/color currently selected. 

Backstitch Eraser    Deletes any lines which start or end in the area
touched by the pointer as it is dragged. 

Color Backstitch Eraser If you wish to erase backstitches selectively,
use the Color Backstitch Eraser. This works in
the same way as the Backstitch Eraser but will
only erase lines in the form/color currently selected. 

Centermark Eraser    Deletes centermarks (arrows or centerlines) which
have been manually placed when you click on
them using this tool. 

Border Eraser Deletes border lines clicked on using this tool. 

Label Eraser Deletes labels when you click on them using this tool. 

When using any of these tools, you can erase large or small areas easily by 
changing the eraser width in the Linesize box.

HINT To erase text, use the Text Tool to select the text, and delete by backspacing 
or highlighting and deleting.



Manipulating sections of the chart
You can use StitchCraft to create your own library of motifs, alphabets and borders 
using the cutout tool and save command. In addition, designs which contain 
symmetrical motifs or repeated patterns can be charted quickly using cutouts. Once
you have charted a basic section, use the cutout tool to highlight it    and then select
the desired command from the Edit menu to either copy, move, crop, flip, mirror, or 
rotate it. See below for more detail on any of these functions.

A warning: you might select a cutout which does not completely contain all the 
elements included in it - such as a backstitch line that starts inside the cutout but 
ends outside of it. If you then instruct StitchCraft to manipulate the cutout, the 
program must decide how to treat those half-in/half-out elements. If proceeding 
means you will lose any information, StitchCraft will provide a warning. 

To move a cutout
To copy a cutout
To delete within a cutout
To crop around a cutout
To flip a cutout
To mirror a cutout
To rotate a cutout



To move a cutout
1. Define a section of the chart with the Cutout tool.
2. From the Edit menu, select Cut.

The contents of the defined section will disappear.
3. If necessary, scroll to the section of the chart where you wish to 

paste the cutout.
4. From the Edit menu, select Paste.

The pointer will change to a paste icon.
5. Click with the pointer on the top-left cell of the desired pasting area.

The cutout will fall to the right of this cell and below it.



To copy a cutout
1. Define a section of the chart with the Cutout tool.
2. From the Edit menu, select Copy.

The contents of the defined section will remain unchanged.
3. If necessary, scroll to the section of the chart where you wish to 

copy the cutout.
4. From the Edit menu, select Paste.

The pointer will change to a paste icon.
5. Click with the pointer on the top-left cell of the desired pasting area.

The cutout will fall to the right of this cell and below it.



To delete within a cutout
1. Define a section of the chart with the Cutout tool.
2. From the Edit menu, select Delete.

The contents of the defined section will disappear, but the dimensions
of the chart will remain the same.



Identifying stitch colors
Sometimes, different shades of the same color are difficult to identify on a chart 
when viewed in color mode. If you want to ascertain which color you have used 
without changing to symbol mode, simply click on the stitch with the right-hand 
button of the mouse. The appropriate entry on the Palette will 'reverse out', making 
it easy to identify. If this is also the color you currently have selected, the Sample 
Box will also 'reverse out' for as long as you hold down the mouse button.

Alternatively, if you are uncertain which color is currently selected, click with the 
right-hand mouse button on the Selection box and the appropriate entry on the 
Palette will be highlighted with a border.



Choosing an unused symbol/color
When you want to select a new symbol/color but are unsure which have been used, 
you can refer to the Palette Info dialog box. This gives details of each palette entry, 
including the frequency of use on the chart.
To identify unused palette entries:
1. From the File menu, select Palette Info.

The Palette Information box appears.
2. Scroll down until you find an entry with '0' in the No. of stitches 

column.
3. Select OK.



Printing a Chart
When you are satisfied with your chart, you will need a print-out for the stitcher or 
knitter's reference. The quality of your print-out will depend on the type of printer 
you have installed: a dot-matrix printer will produce draft-quality and a 300 dpi laser
printer will cope well with small charts printed in a large format. If you want 
professional quality output, you will probably need to take charts on disk to a 
bureau, for printing on a 1200 dpi imagesetter.

When printing, you have various options regarding will take you through those 
options.

Changing printers and printer options
Gridline options
Centermarks and other options
Specifying printed size and position
Printing in color
Printing and saving specifications



Changing Printers and Print Options
StitchCraft prints your charts on the default printer selected in Windows. If you have
other printers installed and assigned as active printers, you can make any of these 
the default printer using the Printer Setup command on the Print menu.

To change printers:
1. From the Print menu, select Printer Setup.

The Printer Setup dialog box appears with
a list of all the active printers.

2. From the Printer box, select the name of
the printer to which you want to change.

3. Select OK. StitchCraft automatically
prints to the newly selected printer.

If you have created a chart that is wider than it is high, changing the page 
orientation will make better use of space, particularly if you wish to print the chart 
as large as possible. By default, one copy will be printed; this can be changed as 
you require.

To change the orientation, number of copies or print scale:
1. From the Print menu, select Printer Setup.

The Printer Setup dialog box will appear.
2. Click on Setup...

A dialog box for that printer will appear.
3. In the Orientation box, click on the desired

option button (portrait or landscape).
Enter the desired number of copies in the Copies box.
Enter the desired scale in the Scaling box.

4. Select OK.
5. Select OK in the Printer Setup dialog box.



Gridline Options
If you were charting manually on paper, you would choose graph paper with an 
appropriate line thickness and weighting. StitchCraft has these same options: line 
thickness and shade can be adjusted and every 5th or 10th gridline can be 
accentuated to make the chart easier to use. Sample gridline settings are shown in 
Appendix X. You can also adjust the thickness and shade of any centermarks, border
and backstitch. 

To change line thickness
To print color gridlines or no gridlines



To Change Line Thickness
1. From the Print menu, select Print Chart.

The Print Chart dialog box appears.
2. Select Options from the Printout section.
3. Use the scroll bars to choose from the different

shade and thickness settings for the appropriate lines.
A sample appears at the right of the scroll bar. If you
are dissatisfied with the changes made, click on
Default to revert to the original settings.

4. Select OK then proceed to print.

By default, the gridlines will be printed in black, but you can choose to print them in
a color (red, green, or blue) or to print no grid lines, or the border only. Selecting a 
color will only have an affect if you are printing to a color printer or in symbol 
overlays or tapestry overlays.



To Print Color Gridlines or No Gridlines
To print color gridlines follow the following:
1. From the Print menu, select Print Chart.

The Print Chart dialog box appears.
2. Select Options from the Printout section.
3. Click on the Grid Color arrow to view options.
4. Highlight the preferred option.
5. Select OK.



Centermarks and other options
Before printing, consider whether you want StitchCraft to add automatic 
Centermarks, Borders or Registration marks (for professional printing). 

Printing with Centermarks & Borders
To print with centermarks, your chart needs to have them before printing. Print Grid 
must also be turned on in the Print Chart dialog box. For information on adding 
centermarks see Auto Markings.    The same applies to Borders. 

To add Registration marks:
1. From the Print menu, select Print Chart.

The Print Chart dialog box appears.
2. Click on the Registration marks box in the

Printout section.
3. Select OK.



Specifying Printed Size and Position
By default, StitchCraft will print your chart centered on the page and sized to fill up 
the page (allowing margins at each side and keeping the width and height in 
proportion). You can adjust the printed size by altering the margins, by specifying a 
height or width, or by specifying a grid size. 

To change the printed size:
1. From the Print menu, select Page Chart.

The Print Chart dialog box appears, select Layout 
from the chart section.

2. Enter the desired measurement in the appropriate section
of the Margins box or Chart box and StitchCraft will
adjust any affected measurements. The resulting count
of cells per cm/inch will appear at the bottom right of
the Chart box. If you make an error, click on Default.

3. For large charts you can have StitchCraft tile the chart over
several printer pages, see Print Tiling for more information.

4. Select OK.

Note: To change the system of measurement from metric to imperial (or vice versa) 
click on the desired option button (cm/inch) in the Printer Page Layout dialog box.

You can also change the position of the chart on the page so that it is not centered 
on the page.

To change the printed position on the page:
1. From the Print menu, select Page Chart.

The Print Chart dialog box appears, select Layout 
from the chart section.

2. In the Position box, select the appropriate options.
3. Select OK.



Printing in Color
StitchCraft offers you six types of direct printed output:

* Symbol charts
* Color charts
* Symbols on colors 
* Symbol overlays 
* Tapestry overlays 
* Full color separation 

Note: depending on the StitchCraft Edition you are using, and which options it has, 
not all of these printout types may be available.
To specify the print output:
1. From the Print menu, select Print Chart.

The Print Chart dialog box appears.
2. Click on the Printout Type arrow to view options.
3. Highlight the preferred option.
4. Select OK.



Print Tiling
When printing a large chart, StitchCraft gives you the option of tiling over several 
printer pages. The number of pages used is displayed as 'Pages in Tile', in the Print 
Chart and Printer Page Layout dialog boxes.



Symbol Chart
Most likely, you will want to print your chart as black symbols with a grid. This 
produces a print-out that can be used as is, or used as artwork for a one-color 
duplication process.



Color symbols
If you have a color printer, you might wish to print your charts with red, green, blue 
and black symbols. When charting (or after the chart is complete), change specific 
black symbols into color symbols . Printing with the color symbol option produces a 
single print-out which could then be copied on a color photocopier, but the process 
is not practical for a large number of copies.



Full Color Charts
Another option is to print a chart in color mode (rather than symbols) on a desktop 
color printer. Again, this could be copied on a color photocopier, but color distortion 
may result and the process is not practical for a large number of copies. This is a 
good option for producing a few attractive print-outs and for proofing purposes.



Black Symbols on Color
If you are using a color printer, there is the further option of printing black symbols 
on to blocks of color. This is useful for distinguishing shades of similar colors. If you 
plan to output charts using this option, avoid using dark colors as the overprinted 
symbols may not be legible.



Symbol Overlays
A relatively inexpensive way of adding color to a chart is to print overlays of 
symbols. When charting (or after the chart is complete), change specific black 
symbols into color symbols . You can then opt to print color overlays and StitchCraft 
will produce up to four overlays as required to complete the chart. When you take 
these overlays to a commercial printer, you can choose suitable colors for 
reproduction. 



Tapestry Overlays
This option will produce the Artwork for screen printing of Tapestries. Each 
separation will show one thread color only, with the necessary overlap (or trapping).
This overlap is important as it prevents bare canvas showing through if there is any 
variation in registration while the job is being printed.
When printing or exporting Tapestry overlays, it is important to first order the colors 
in the palette in the sequence that they will be printed (i.e. the first color to be 
screen printed should be palette entry 1). This sequence is usually from lightest to 
darkest. The reason for this need to order the colors, is so that the correct overlaps 
can be given to each overlay.
To re-order the palette entries use the palette Move Entry command to move each 
color to the required position in the palette.
Check with your printing company as to the required overlap, in StitchCraft this is 
expressed as a percentage of a cell. 0% gives separations that have no overlap at 
all, 50% will give separations that have an overlap of half a cell.

HINT Make sure you provide your printing company with a list giving the sequence 
for the separations, so that they can print them in the correct order.



Full Color Separation
If you require accurate separations of the charted colors for commercial printing 
using process colors, you will need to export your charts to a WMF format . From 
these, a bureau can produce color separations - four pieces of film that combine to 
represent the charted colors. These separations can then be used for printing in 
process colors and will give you a chart which closely matches the colors you have 
selected from the thread library, color wheel or RGB values. This is really only viable
for a simple chart in distinct colors; shades of one color may be difficult to 
distinguish. If your chart has a complex color scheme, consider exporting it with 
black symbols on color blocks.

HINT Before the bureau produces film, it is advisable to print a full color proof on a 
desktop color printer.



Printing and saving print specifications
When you select Print Chart from the Print menu, the Print dialog box appears, 
giving you a summary of the options and settings. If you wish to, you can review 
and adjust any of the following:
Setup - to change the target printer or page orientation
Layout - to change printed size or position on the page
Options - to change gridlines, centermarks, and so on.
If you are satisfied with the settings, you can proceed to print by selecting OK. 

If you save the chart after defining your print options, the current print settings will 
be saved along with the chart. Use the File menu and the Save command to retain 
your print settings. 



Customizing StitchCraft
There are many ways you can customize StitchCraft to your own needs.
These include:

Adjusting the autosave
Enlarging the charting area
Viewing sizes
Viewing modes
Rulers and Co-ordinates
Grid Start
Grid Styles
Specifying chart size
Manipulating the palette
Altering symbols and colors
Matching colors with commercial thread colors
Preferences



Saving Automatically
To avoid loss of large blocks of work through power failure or error, StitchCraft offers
a choice of automatic saving facilities. On the default setting, a reminder notice will 
appear every ten minutes (unless you have made no changes in that time) and will 
give you the choice of saving or not. You can change this setting by:
* turning off the autosave altogether
* having StitchCraft save automatically with no reminder notice
* changing the timer interval 

To adjust the Autosave options:
1. From the File menu, select Autosave.

The Autosave dialog box appears.
2. Select the appropriate mode option 

button or type the interval length 
in the Timer box.

3. Click OK.



Enlarging the Charting Area
You can remove the Toolbox, Linesize box, Ruler and Palette from the StitchCraft 
window to increase the size of the charting area. You can still select different tools, 
linesizes and palette items by using the menu commands. 

To remove various items from the window:
1. From the Screen menu, choose View.

The View dialog box appears.
2. Click in the check boxes beside Tools, Ruler and Palette.
3. Select OK.
To return them to the window, repeat the instructions.

You can also remove sections of the Palette, such as the symbol section (if you only 
want to work in color blocks) or the number section.

To remove sections of the Palette from the window:
1. From the Screen menu, choose Palette Display.

A sub-menu appears.
2. Select the appropriate entry.
To return them to the window, 
repeat the instructions.



Viewing Modes

Charts can also be viewed in two modes:
* as symbols - essential if your chart will be printed in one color
* as color blocks - useful for viewing how the stitched piece will appear
To change the viewing mode:
Click on the option button beside the appropriate section of the Palette 
ie. the symbol row or color row.
The chart will be redrawn in this mode.



Grid Styles
Your chart can be viewed with different styles of grid. The default setting is a heavy 
solid line every tenth line, with a dashed line at lines 5, 15, 25, and so on. However, 
you can choose to have a heavy line every fifth line or all lines of equal weight. If 
you want to view the effect of your design clearly, you can choose a dot grid. If you 
are designing a knitting pattern and you wish to see how knitted stitches will distort 
the design, you can select a knitting grid.

To change the grid type on the screen:
1. From the Screen menu, select Grid Type.

A sub-menu will appear.
2. Select the appropriate sub-entry.

The grid type will change.

Also see:
Custom Grid
Grid Color



Specifying Chart Size
When you start up the StitchCraft program, a default chart measuring 100 x 100 
cells appears on the screen. To set up a chart to your own specifications, you can 
either create a new one or adjust the existing one.

To create a new chart:
1. From the File menu, select New 

(or press CTRL + N).
A New Chart dialog box appears.

2. If you require new dimensions,
click on New Size and select OK.
The Resize Chart dialog box appears.

3. Enter the desired width (ie. the number
of cells you want across the width of the chart).

4. Tab to the next choice and enter the
desired height (ie. the number of cells high).

5. Select OK.

Also see:
Adjusting the size of an existing chart
To Insert Columns/Rows



To Adjust the Size of the Existing Chart

To adjust the size of an existing chart:
1. From the Size menu, select Resize.

The Resize Chart dialog box appears 
2. Enter the preferred width and height as per the instructions above.

This will affect the chart's right-hand side or base, by either adding more 
columns/rows there or by deleting some existing columns/rows. If this will result in 
the removal of columns/rows where stitches have been drawn, a warning box will 
tell you how many stitches will be affected and you can choose to proceed or cancel
the command.



To Insert Columns/Rows 
You can also insert or delete columns and rows at particular sites; this allows you to 
change the size of the chart without affecting the work you have done so far. You 
will need to calculate the location on the chart where this is required and the 
number of columns/rows you want inserted or deleted.
To insert columns:
1. From the Size menu, 

select Insert Column.
The Insert Columns dialog 
box appears.

2. Type the number of the column where you
want the first additional column to appear.

3. Tab down and type the number of additional
columns required.

4. Select OK.

To add rows, or to delete columns or rows, simply select the appropriate heading 
from the Size menu and follow the instructions above. A warning box will appear if 
you have asked to delete rows/columns where stitches have been drawn and you 
will have the option of proceeding or canceling the command.



Manipulating the Palette
The default palette contains 50 entries in a certain sequence. You can manipulate 
this to suit your own purpose: the palette can be 'minimized', entries can be added 
or deleted, and the sequence can be changed.
see:

Reducing the palette
Adding and deleting entries
Moving and swapping entries
To swap two palette entries
To merge two palette entries
Saving a palette



Reducing the Palette
If you find it confusing to work with the whole of the default palette, you can reduce 
the number of entries so that your options are visible at a glance. StitchCraft has 
the facility to reduce the Palette to show only those symbols/colors which have been
used on the chart. 
To reduce the Palette:
1. From the Palette menu, select Auto Minimize Palette.

A warning appears stating how many unused entries will be deleted.
2. Select OK if you are satisfied, or Cancel to escape.

HINT If you know which colors you want to use in your chart, 
draw a stitch of each color in the top right hand corner where 
they can be erased later. Then reduce the Palette as above.



Adding and Deleting Entries
Once you have minimized the Palette, you may find you need to add an entry to 
represent a new color in your design. Alternatively, you might want to add a 
customized symbol/color. You can add an entry at any position in the Palette at any 
stage while charting.

To add a palette entry:
1. From the Palette menu, select Alter Palette.

A sub-menu appears.
2. Select Add Entries.

The Add Palette Entries    dialog box appears.
3. Type in the desired position of the first new

entry (the default is after the last entry).
4. Type in the number of new entries required

at that position (the default is 1 entry).
5. Select OK.

A blank entry will be inserted at the position
you have indicated and you will need
to allocate a color and symbol to that entry.

6. Double-click on the color section of the blank
entry. The Alter Color dialog box appears.

7. Click on the desired hue and saturation on
the color wheel. The selected color will appear
in the sample box. 

8. Double-click on the symbol section of the
blank entry. The Alter Symbol dialog box appears.

9. Select an alternative symbol, using the scroll bar
to view all the options. Click on the symbol you
wish to substitute; your selection will appear in the
sample box at the right. If you select a symbol that
is already in the Palette, a warning box appears. 

To Delete a Palette Entry
1. From the Palette menu, select Alter Palette.

A sub-menu appears.
2. From the sub-menu, select Delete Entries.

The Delete Palette Entries dialog box appears.
3. Indicate the position of the first and last entries

you wish to delete. All entries between these
two will be deleted. If you only wish to remove
one entry, indicate the same entry in both boxes.

4. Select OK.
StitchCraft will warn you if any stitches have been
charted in a palette entry about to be deleted.



Moving and Swapping Entries
You may wish to rearrange the Palette so that your most frequently used 
colors/symbols appear towards the front, or to put them in order of catalog number.

To move a palette entry:
1. From the Palette menu, select Alter Palette.

A sub-menu appears.
2. From the sub-menu, select Move Palette Entry.

The Move Palette Entry dialog box appears.
3. Enter the position of the palette entry you wish to move (or use the scroll bars to 
locate it).
4. Enter the new position of the palette entry (or use the scroll bars to locate it).
5. Select OK.

You can also swap the position of two entries on the Palette. Note that this will not 
affect any stitches charted in these symbols/colors.



To swap two palette entries
1. From the Palette menu, select Alter Palette.

A sub-menu appears.
2. From the sub-menu, select Swap Entries.

The Swap Palette Entries dialog box appears.
3. Enter the position of the first palette entry you wish to move (or use the scroll 
bars to locate it).
4. Enter the position of the second palette entry you wish to move (or use the scroll 
bars to locate it).
5. Select OK.



Merging Entries
You might find that you have used two different symbols to represent the same 
thread color or that you want to eliminate a color from the chart. Rather than 
redraw half the stitches, you can merge two entries into one.

To merge two palette entries:
1. From the Palette menu, select Alter Palette.

A sub-menu appears.
2. From the sub-menu, 

select Merge Entries.
The Merge Palette Entry
dialog box appears.

3. Enter the position of the palette entry no longer
required (or use the scroll bars to locate it).

4. Enter the position of the palette entry you wish
to merge it with (or use the scroll bars to locate it).

5. Select OK.



Saving a Palette
Once you have modified the Palette for a particular chart, you might want to save it 
for use with a new chart. Palettes can be saved on their own, independent of the 
chart; such files can be identified by their *.PLT extension.

To save a palette:
1. From the Palette menu, select Save Palette.

The Save File dialog box appears, with a directories list.
2. Select the directory in which you want to save the file.
3. Move to the Filename text box and type the name you want to assign to the file.

Stitch-Craft offers an automatic extension (*.PLT). 
4. Select OK.



Altering Symbols and Colors
Choose from the following to adjust the palette and its colors:

Open a palette
Altering symbols
Altering backstitch format and color
Creating custom colors



Opening a palette
When you create a new chart by selecting New from the File menu, StitchCraft gives
you the option of using the default palette, the present palette (ie the one currently 
on your screen), or of opening a palette that has been saved as an independent file.
To open an existing palette:
1. From the File menu, select New. 

A New Chart dialog box will appear .
2. In the Palette section, click on the Open button and select OK.

A Directories list box appears.
3. Double-click the directory that contains the palette you want to open.

All files with a *.PLT extension will appear in the file list.
4. Double-click on the palette file that you want.



Altering Symbols
Having started your chart, you may wish to alter a symbol already used: perhaps 
two symbols you have used look too similar when juxtaposed or you decide you 
want a heavy symbol to represent a dark area. Symbols can be altered at any stage 
of charting.
To alter a symbol:
1. From the Palette, select the symbol you want to alter.
2. From the Palette menu, select Alter Symbol.

The Alter Symbol dialog box appears .
3. Select an alternative symbol, using the scroll bar to

view all the options. Click on the symbol you wish to
substitute; your selection will appear in the sample
box at the right.

StitchCraft offers a default range of fifty symbols. However, there are many more 
options if you vary the color of the symbol or the shade of foreground and/or 
symbol. The color of a symbol will be visible on a color monitor; if you choose to 
print overlays for spot printing it will appear on the appropriate color overlay.
If you wish to create a customized symbol:
4. Select a color from the second column in the

Alter Symbol dialog box, and/or select a
foreground/background shade combination;
your selection will appear in the sample box at the right.

5. Click OK and your new selection replaces
the original selection in the Palette.

HINT To move quickly to the Alter Symbol dialog box, double-
click on the symbol that you want to alter in the Palette. 

Symbols should be selected carefully, keeping in mind their clarity and how they 
appear in combination with other symbols. The default palette is roughly arranged 
in order of clarity, with the most easily identified symbols at the far left. Another 
consideration is whether you want to try and match the dark colors on your design 
with heavy symbols, so that the finished chart conveys the 'weighting' of the design
when in symbol mode. StitchCraft offers a matching feature for symbols: you can 
choose to match the default range (in order of clarity) or to rearrange your existing 
symbols in order of weight.
To automatically match symbols:
1. From the Palette menu, select Auto Match Symbols.

The Auto Match Symbols dialog box will appear.
2. Click on the appropriate option button.
3. Select OK.

The palette will be rearranged, either in order of clarity 
or of symbol weight.



Alter backstitch format or color
Some designs feature backstitching in various thread colors. If there is a chance of 
confusing these threads, you can distinguish between them by printing 
backstitching in various colors (if you have the facility for spot printing) or by using 
different line styles (solid lines, dotted lines, dashed lines, etc) in black. In 
StitchCraft, each symbol has a linked backstitch format, and you can change 
backstitch formats just as you can symbols.
To alter a backstitch color or format:
1. Select the symbol (and therefore linked backstitch)

that you want to alter.
2. From the Palette menu, select Alter Symbol.

The Alter Symbol dialog box appears .
3. Select an alternative line style from the Backstitch

column (and/or an alternative color); the selection
appears in the sample box at the right.

4. Select OK.

When you wish to use the new backstitch style, select the linked symbol from the 
Palette and the Backstitch Tool from the toolbox, then draw backstitches as usual. 
You will only be able to see the format of a backstitch line (ie whether it's dotted, 
dashed or solid) if you are viewing the chart in symbol mode.



Creating Custom Colors
Colors can be described according to various models. StitchCraft offers three color 
models: HSL, RGB and a thread library.

* HSL defines color as a degree (from 0 to 360) of hue
and as a percentage of saturation and of luminosity.

* RGB defines colors as percentages of red, green, and blue light.
* The thread library allows you to match a color to an existing

thread color in various brands (DMC, Anchor, Coats, Semco,
Appleton) or to specify a catalog number and have that color
appear automatically.

You can alter the default colors in the StitchCraft Palette at any time when charting. 
You can create your own colors using the HSL or RGB models, use these to select a 
matching color from the thread library, or fill your palette by specifying catalog 
numbers from the thread library.

The accuracy of the colors you see on your screen depends on the type of monitor: 
for example, EGA and VGA monitors may break up the color into crude blocks 
(known as 'dithering') while a SuperVGA will display well-mixed colors.

To alter a color by HSL:
1. From the Palette, select the color you want to modify.
2. From the Palette menu, select Alter Color.

The Alter Color dialog box appears.
3. Click on the desired hue and saturation on the color

wheel (you can drag the pointer around to view different
options). The selected color will appear in the sample box. 

4. Use the scroll bar to adjust luminosity. View the affect on
the color in the sample box.
The selected values will appear in the hue, saturation and
luminosity boxes, which can be adjusted by entering new values.

5. When you are happy with the color achieved, select OK.
Alternatively, you can select Match to have StitchCraft search
for the closest color in a commercial thread .

To alter a color by RGB:
1. From the Palette, select the color you want to modify.
2. From the Palette menu, select Alter Color.

The Alter Color dialog box appears.
3. Type required RGB values in the individual red, green,

and blue percentage boxes. 
The selected color will appear in the sample box.

4. When you are happy with the color achieved, select OK.
Alternatively, you can select Match to have StitchCraft
search for the closest color in a commercial thread.



To alter a color by selecting a catalog color:
1. From the Palette, select the color you want to modify.
2. From the Palette menu, select Alter Color.

The Alter Color dialog box appears .
3. Click on the Select button. 

The Select Thread dialog box will appear.
4. Click in the button beside the desired brand in the

appropriate thread type (stranded cotton or tapestry wool).
You can only select one button at a time.

5. In the Cat. No. box, enter the catalog number for the desired color 
of thread.

6. Select OK.

HINT To move quickly to the Alter Color dialog box, double-click
on the color in the Palette that you want to alter.



Matching Thread Colors
When you have mixed a color, you may want to use the closest commercial thread 
color. StitchCraft has a library of colors in the major brand ranges: Anchor, DMC, 
Coats, Semco and Appleton. These colors serve as a guide only, due to the 
limitations of color reproduction and dye lot differences. For perfect matching, refer 
to actual thread samples.

To match a color:
1. From the Palette, select the color you want to modify.
2. From the Palette menu, select Alter Color.

The Alter Color dialog box appears .
3. Mix your desired color, using HSL or RGB methods described above.
4. When you are satisfied with the sample color, click on the Match box.

The Match Thread dialog box appears.
5. Click on the desired brand(s) in the appropriate thread types.

If you select multiple boxes, StitchCraft will search through
all the selected ranges and choose the single color closest to your sample.

6. If you are satisfied with the matched color, select OK.

HINT At any time, you can find out if a palette color has been 
matched by choosing Palette Info from the File menu.

To save you the inconvenience of matching each color one at a time, StitchCraft 
offers the facility for automatically matching the whole color palette to a brand of 
commercial threads.

To automatically match all colors with one brand:
1. From the Palette menu, select Auto Match Colors.

The Match Colors dialog box appears .
2. Click on the desired brand in the appropriate thread type.
3. Select OK. 

The complete color palette will be matched to that brand.





The Charting Area
A blank chart, measuring 100 cells high and 100 cells wide, appears as the default 
setting. The window only reveals a part of this chart; scroll bars along the bottom 
and right-hand side of the window enable you to view other sections.



The Pointer
The cursor or arrow on the screen that follows the movement of the mouse and 
indicates which area of the screen will be affected when you press the mouse 
button. The pointer changes shape during certain tasks.



Control Menu
The control menu, located in the upper left-hand corner of the window, allows the 
running application to be rearranged on the desktop.



Main menu
A list of available commands. Menu names appear in the bar near the top of the 
StitchCraft window. You open a menu by selecting the appropriate name.



The Viewfinder
The Viewfinder allows you to zoom in and out of a chart section.



Toolbox
The Toolbox contains the tools that you use to complete the chart. The tools allow 
you to place symbols or colors, erase, fill, add lines, add text, and rearrange 
sections of the chart.



The Palette
The range of 'chart fillers' (ie symbols or colors) immediately available on the 
screen. The default palette contains 50 entries, but this can be increased or 
changed in various ways.



The Ruler
The Ruler running along the top and left of the charting area indicates which section
of the chart is visible. It is a useful reference when you are adding or deleting 
columns/rows and need to specify position.



BMP
The automatic extension name for bitmap files.



Bitmap
A computer graphic formed by a series of dots, created in a paint program or 
scanned from a picture.



Dots per inch (dpi)
A measure of image resolution; the more dpi (dots per inch) the sharper the 
resolution.



Icon
A graphical representation of various elements in windows, such as applications.



Ram
Random Access Memory; the working memory of a computer, as opposed to the 
storage memory of the hard disk. When you turn the computer off, all information in
Ram is lost.



Red, Green, Blue (RGB)
A color mode that defines colors by their proportions of red, green, and blue.



Scanner
A hardware device that reads information from a photograph or other pictures and 
converts it into a bitmapped graphic.



Scan
A bitmap created when a photograph or other picture has been read by a scanning 
device.



Ellipse
A shape with curved edges, such as an oval.



Ellipsis (...)
The ellipsis indicates that a dialog box will appear when that command is chosen. 
The dialog box will ask you for more information before continuing with the 
command.



Scroll bar
A bar that appears at the right and/or bottom edge of a window or list box whose 
contents are not completely visible. Each scroll bar contains two scroll arrows and a 
scroll box, which enable you to scroll through the    contents of the window or list 
box



Maximize
To enlarge a window to its maximum size by using the Maximize button (at the right 
of the title bar) or the Maximize command on the Control menu.



Minimize
To reduce a window to an icon by using the Minimize button (at the right of the title 
bar) or the Minimize command on the Control menu.



Command
A word or phase, usually found on a menu, that you choose in order to carry out a 
task.



Dialog box
A rectangular box that appears on screen and either requests or provides 
information.



File
In StitchCraft, a chart or palette that has been saved and given a name.



The Maximize/Minimize and resize icon
The maximize/minimize and resize icon, which is located in the uppermost right of 
your screen, offers you the capability to make the window smaller or larger or 
reduce the StitchCraft program to an icon .



Linesize box
The Linesize box in the bottom left contains different widths for drawing and 
erasing.



Selection box
The Selection box located left of the palette, indicates to the user what color or 
symbol is currently selected.



Cell
A square of white in the chart ,used to represent a single stitch in cross-stitch, 
needlepoint or knitting.



Backstitch
A straight stitch used in cross-stitch designs for outlining or detail; in the StitchCraft 
program ,this term refers to the lines which represent this stitch.



Centermarks
Marks used to indicate the center of the chart; these can be arrows or intersecting 
lines.



Copy
To put a copy of the selected cutout on the clipboard so you can transfer it to 
another location, leaving the original item intact.



Count
The number of threads per inch or centimetre of a particular fabric.



Crop
To trim the area surrounding a selected cutout.



Default
A series of settings that StitchCraft uses automatically unless you specify otherwise.



Directory
A collection of files and subdirectories that are stored at the same location on a 
disk.



Double-click
To rapidly press and release a mouse button twice without moving the mouse.



DTP
Desktop publishing: the use of the computer to collate text and graphics to produce 
a complete document.



EGA
Extended graphics adaptor ;16-color, low resolution computer screen.



Export
To make a copy of the chart (with settings) in another format so that it can either be
separated by a commercial printer or pasted into a desktop publishing application.



Extension
The period and three letters at the end of a file, used to identify the type of 
information contained.



Flip
A command which 'turns over' a selected cutout ,either vertical or horizontally.



Font
A collection of characters which form a particular typeface, such as Times Roman or 
Helvetica; the range available to you will be dictated by your printer.



Halfstitch
A stitch commonly used in cross-stitch designs and which covers a diagonal half of a
block of threads.



HSL
A color model that defines screen colors in terms of hue, saturation and luminosity.



Key
A visual guide for the user of your chart, indicating which thread colors are 
represented by which symbols or chart colors.



Import
A bitmapped image which has been introduced into the StitchCraft program so you 
can chart over it.



Label
A chart area of solid white for displaying text or simply removing grid lines.



Border
A line which can be used to accentuate the edges of a chart.



Material count
The number of treads per inch or centimetre of a particular fabric.



Mirror
A command which copies a selected cutout and places the second image aside the 
original as if it is a reflection.



Motif
An identifiable element of a design ,such as heart or bird.



Option button
A small round button that appears in some dialog boxes. Within a group of related 
buttons, you can select only one.



Orientation
The position of a printed chart on a page; 'portrait' aligns the top of the chart with 
the narrow edge of the page, 'landscape' aligns the top of the chart with the edge of
the page.



Overlays
Versions of a chart that each show only one color from the chart and that can be 
combined by a commercial printer to create the finished chart.



Paste
To copy the contents of the clipboard into an application.StitchCraft will only paste 
material generated in StitchCraft.



Registration marks
Marks that StitchCraft can add to your printed page or exported file to show a 
commercial printer where to align color overlays.



Resolution
The number of dots that make up an image on a screen or printer. The higher the 
resolution ,the smoother images will appear.



Separation
The process of splitting colors into components which can then be used by 
commercial printers to reproduce full color charts.



Shortcut keys
Key combinations that act as a shortcut for specific tasks.



Spot colors
A method of assigning colors in a chart so that they can be reproduced with a 
number of overlays.



Stitch
In StitchCraft ,a single chart cell which has been colored or filled with a symbol.



Super-VGA
A computer screen which can display 256 colors at a high resolution.



True type fonts
Fonts that can be sized to any height and will print exactly as they appear on the 
screen.



VGA
Video graphics adaptor; a 16-color ,high resolution computer screen.



WMF
A file format known as Windows Metafile. When you export a Stitch Craft file, it is 
converted into WMF format.





CMYK
A color system that defines colors by percentages of Cyan, Magenta, Yellow and 
Black.



Auto Conversion
With the Auto Conversion feature of StitchCraft you are able to convert imports 
quickly using the Auto Convert command. The quality of the resulting chart will 
depend on the quality of the original image and it will require some manual work to 
perfect it, but for complex images it is an efficient method of charting. When using 
the Auto Conversion facility, it is important to obtain a high quality scanned image. 
Scan your image at the highest resolution possible to produce a file no larger than 
1.2 Mb (perhaps 75 dpi for a large image and 150 dpi for a small one). Save the 
image to disk using .BMP 256 color format or copy it to the Clipboard.

To automatically convert an image:
1. Size the chart as required using the Chart/Size/Resize commands.
2. Import the image using the Import/Import command.
3. From the Import menu, select Auto Convert.

The Auto Convert dialog box appears.
4. Select the desired thread type and brand.
5. Select the palette source and size.
6. Select any other desired options (more details follow).
7. Select OK. The image will be converted into a chart.

If your import featured a picture or motif on a background and the chart is intended 
for cross-stitching, delete the relevant background color from the Palette using the 
Palette/Alter Palette/Delete Entries commands, or use the standard eraser tool.

Palette options
             Color Options

Dither Options
Edge detection
Remove single stitches
Controlling color selection
Remove Import



Palette options
Decide whether you want StitchCraft to create a new palette based on the colors in 
the import (the default option) or if you prefer it to use the existing palette (i.e. the 
one that is currently at the bottom of the screen).
If you have opted to create a new palette, you must also choose the palette size. 
You have a choice of:
* specifying the exact number of colors you want used - the minimum is two and 
the maximum is determined by the thread range selected
* auto small - includes any colors which make up more than 2% of the image
* auto medium - includes any colors which make up more than 1% of the image
* auto large - includes any colors which make up more than 0.25% of the image.

The size of palettes created by the auto options will therefore vary from picture to 
picture.



Color Options
There are three options you can use to specify the type of colors to be used in the 
chart.
* Color chart - standard color chart
* Flesh tones - this option should be selected when an image includes any human 
faces. When Flesh tones has been activated, StitchCraft will search the image for 
skin colors and select more of these for the new palette than it would on a standard 
color conversion.
* Monochrome - this is for converting a color or monochrome image to a 
monochrome chart. For example; if a chart using only sepia colors is required, this 
setting would be selected. It is important to create the palette you desire to use 
before performing the Auto Conversion. This setting must be used in conjunction 
with the 'Use current palette' setting in the Palette choice drop down list (see 
Palette options).



Edge Detection
StitchCraft calculates the closest color to each cell of the import. If a cell contains 
two areas of color, for example blue and red, StitchCraft will, by default, merge the 
colors and select purple. If you activate Edge detection, it will calculate whether the 
cell is predominantly red or blue and select that color. In general, you should use 
Edge detection if the image has large areas of pure color rather than mottled or 
dithered colors.



Remove Single Stitches
This option removes all isolated stitches (i.e. those with no other adjoining stitch in 
the same color) from the converted image, making stitching easier but also 
simplifying the image. This option would not usually be used in conjunction with the 
dither option.



Remove Import
This option removes the import after the conversion is complete.



Controlling Color Selection
There will be many occasions when the Auto Conversion process makes decisions 
which you would not have made when charting. You may, for example, wish to 
select the colors yourself and let StitchCraft chart from that selection. One approach
to auto-converting an image follows:
1. Open a new chart.
2. Import your image.
3. Reduce the Palette (i.e. to nothing).
4. Depress the INSERT key and click on selected areas

of the import with the right-hand mouse button.
In this way, you build up a Palette of these selected colors.
NB. Make sure that white is included in the Palette
if the scan has a white background

5. Select the Auto Conversion command and select the
‘Use existing Palette’ option.

6. After conversion is complete, clear the import.
7. Delete the background if required



Grid Color
There are five different grid colors available; Black, White, Red, Green and Blue. 
When used in conjunction with material color, grid color can be used to improve the 
legibility of a chart, both on screen and on a color printout.



Scroll Bars
These allow you to view sections of the chart or palette not currently visible.



Repeat
Use the Repeat Command to



View Clipboard
Use this command to view the contents of the Windows Clipboard. The Clipboard 
will display the last item cut or copied (see your Windows manual for further 
information on Clipboard).



Paste Options
Use the Paste Options command to



Fly Out Menu
A menu that appears to the side of the currently selected menu, showing further 
options or commands.



New Palette
The New Palette command enables you to load a new palette into the chart you are 
presently working on. Any unused palette entries will be deleted, entries that are in 
use will remain. If you do not want unused entries to be deleted, you should use the 
Add Palette command instead.



Add Palette
The Add Palette command enables you to add a new palette into the palette you are
presently working with. Unlike the New Palette command unused entries will not be 
deleted. 



Zoom Out Tool



Print Palette
Use the Print Palette command to print the palette information from the current 
chart. The Print Palette dialog box will appear and you can select the target printer 
and the number of copies. After this you will be asked which pages you would like 
printed if there are more than one.



Search for Help on...
If you would like Help with a particular subject or command, just enter the word in 
the Search for Help dialog box and select Show Topics. This will then list one or more
topics in StitchCraft Help that are relevant to your entry. You can then select any 
one of these and click the Go To button to view the topic.



How to use Help
This command will bring up Windows Help - describing the basics of how to use 
Help. 



Context Sensitive Help
This command will change the pointer to a question mark, with which you can click 
on various ares of the screen and StitchCraft Help will be opened displayed the 
relevant information.



Sorry ...
This Help topic is not available in this demonstration copy of StitchCraft.



StitchCraft Basics

Basics
The StitchCraft window
StitchCraft menus
Using Help



How To...
This section of Help will show you how to perform various functions in StitchCraft. 
You can choose from any of the topic areas listed below.
 

Create a simple chart
Edit your chart
Print
Import images
Export charts
Customize StitchCraft






